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About DigivibeMX® Version 11 

 

What is DigivibeMX®? 
  

DigivibeMX® is a versatile, multi-functional software capable of analyzing machine vibration in real time, performing 

traditional route data collection and balancing single-plane or two-plane rotors – in-situ or on Soft Bearing Suspension 

balancing machines. The DigivibeMX® model purchased determines which software capabilities are available for the user. 

 

• DigivibeMX® M10 provides dynamic balancing capabilities only 

• DigivibeMX® M20 provides route and off-route vibration data collection and analysis capabilities only 

• DigivibeMX® M30 combines the full balancing and vibration analysis capabilities of M10 and M20. 

• DigivibeMX® Phantom supports remote machine health monitoring and analysis using our Phantom sensors.  

 

DigivibeMX® combines powerful machine health monitoring tools with easy-to-use functions and easy-to-interpret visual 

interfaces. The software provides immediate capabilities for inexperienced users, and more sophisticated tools for 

experienced users seeking a full range of analysis capabilities. 

  

Functions include: 

 

• Real-time vibration waveform and FFT spectrum analysis 

• Single-plane or two-plane dynamic rotor balancing with weight calculator 

• Balancing Wizard enables Soft Bearing Suspension dynamic balancing without trial weights 

• Automatic RPM filtering 

• Orbital Analysis 

• Circular Time Waveform signal rendering 

• Automatic generation of vibration analysis and balancing reports (compatible with Microsoft Word and Excel 2007) 

• Powerful SQL database 

• Accuracy up to +/- 0.1 RPM 

• Up to 2 million lines of resolution 

• ODS simulation features built into the software, compatible with imported .obj .xaml and .3ds modeling files 

• ISO or customizable band alarms for Velocity and Acceleration Enveloping  

• Individual enveloping alarms for establishing machine baselines  

• Trigger recording 

• Simultaneous or sequential recording of 2 planes for dynamic balancing. 

  

DigivibeMX® Is distributed with electronic equipment and optional accessories approved by Erbessd Instruments®.  

  

Visit our page for more information on available equipment.  

http://www.erbessd-instruments.com 

 

 

  

http://www.erbessd-instruments.com/
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Types of sensors 

DigivibeMX®v11 wired interface systems include the following sensors: 

100 mV/G Accelerometers: 

Vibration sensors. Their output voltage is proportional to the acceleration of vibration.  

Used for:  

- Dynamic Balancing in 1 and 2 planes 

- Vibration Analysis 

- Route Data Collection 

- Capturing ODS modeling data 

Laser Optical Sensor: 

Laser-emitting speed sensor: 

Used for: 

- Measuring rotational speed (CPM or Hz) 

- Dynamic Balancing (Phase Angle) 

System requirements 

Minimum requirements of a desktop, laptop or tablet computer* for DigivibeMX® v11 software installation: 

* Not compatible with Windows RT operating system 

• Intel® i3® (2.50 GHz / 400MHz) or higher 

• Minimum 4GB DDR2 or higher RAM 

• Windows 10 (*supports Windows 8 and 8.1) 

• SVGA or higher monitor (enhanced for touch screens) 

• 750 MB of minimum disk space 

• 1 USB 2.0 port 

• Internet connection (for software installation and activation only) 

 

Other Required Software: 

- MySQL Connector Net 6.5.4 (Included with system purchase) 

- SQL Compact server 3.5 SP2 (Included with system purchase) 

- Microsoft Word 2007 or higher (for reporting features) 

- Acrobat Reader 7.0 or higher (for opening help guide) 
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Software Installation 

From USB or Download:  Open the DigivibeMX® folder location in Windows Explorer: 

1. Open and install SSCERuntime_ (x64 for 64-bit operating systems; x86 for 32-bit operating systems) 

2. Open and install vcredist (x64 for 64-bit operating systems; x86 for 32-bit operating systems) 

3. Open and install MySQL-Connector-net.6.5.4.msi 

4. Open and install setup.exe 

 

Product Activation 

IMPORTANT: Activating DigivibeMX® software requires an Internet connection!   

 Upon first launch of DigivibeMX®, you will receive the following message. Click Yes to register: 

 

Enter your Username and Activation code. Click Activate: 

 

Enter your username and activation code in the corresponding boxes. 

The key consists of 16 characters, for example WWWW-YYYY-WWWW-YYYY (do not include dashes). 

 

Important: An active internet connection to the Erbessd licensing server is required to activate the software. Sometimes 

industrial, business or university networks prevent connection due to firewalls. If this occurs, you will receive an SQL error 

message. If necessary, consider activating the software from a different network (personal cellular network, for example). 

1 

2 
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Calibration 

 

The following Erbessd Instruments interfaces and wireless devices are pre-calibrated on their chipsets. They do not require 

calibration in DigivibeMX® software: 

 

        

 

 

The following legacy wired interfaces must be calibrated in DigivibeMX® before performing vibration analysis or dynamic 

balancing. Calibration data is unique and specific to each individual interface. Therefore, it is also necessary to ensure the 

interface being used is correctly identified in the software before collecting data. Otherwise, collected data will likely be 

displayed inaccurately. This procedure is required during initial product activation. It will also be necessary to recalibrate if 

you ever upgrade DigivibeMX® software, modify the initial calibration file or completely reformat the computer. 

               

 

 

 

 

 

 

INT4-GX4 (GX-400)                    WiSER               WiSER3x                  PHANTOMS 

           INT2-15A (I-500)          INT2-16A/INT2-17A (I-600/I-700)             INT4-18x (I-800) 
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To calibrate: Connect the 2 or 4 channel interface to the computer via USB. Connect the calibration device to the Op port 

using the 5-pin Tachometer cable, as shown. Ensure the computer recognizes that a new device has been installed.  

 

On the DigivibeMX® Configuration menu, click Select Device and verify that DigivibeMX® detects the connected interface. 

If no device is found, exit the software, check all connections, restart DigivibeMX® and recheck. 

 

Confirm the interface is detected by DigivibeMX® and click Accept 

 

 

 



 
 

9 
Erbessd Instruments – DigivibeMX 11.50 noviembre 2022 

On the Configuration menu, click Calibration 

 

The Calibration window opens. Select your Interface. Select the Channel to which the Calibration device is connected. Then 

click Calibrate.  

 

 

The following screen confirms a successful calibration. DigivibeMX® is now ready for use with the calibrated interface. 

 

 

 
 

  



 
 

10 
Erbessd Instruments – DigivibeMX 11.50 noviembre 2022 

Other Configuration Menu Controls 

Signal and Channel Preferences 

 

Users should review the Signal and Channels settings in Preferences and make desired changes, before attempting to 

record or analyze data. Open the Configuration Menu and select Preferences: 

 

 
 

The Preferences window opens, containing three tabs for user-defined options 

Signal Tab  

 

The Signal tab is used to specify default data recording, filtering and display parameters  

 

▪ Time (secs): This tool is very useful to calculate resolution lines 

depending on a defined time. This way the selection of 

resolution lines will be more precise. 

▪ Resolution Lines: Specifies the default lines of resolution for 

data collection. Detailed information about how the specified 

Resolution Lines affect Resolution Points and Frequency Range 

are also displayed. Adjustments can be made for specific data 

collection points when creating Routes, as desired.    

▪ RMS Filter Hz: Sets RMS filter rage. Default is 11-11000 Hz. 

▪ Low Frequency Filter button: Toggles the low-frequency filter 

ON or OFF. Eliminates the low frequency ski-sloping and 

haystacking noise traditionally seen in FFT displays. 

▪ Units: Select between Imperial or Metric default units.  

▪ FFT Frequency: Select between Hz, CPM or Orders default 

units. 

▪ Type Interface: Identifies the current or most recent 

DigivibeMX Interface model connected. Should be confirmed 

prior to data collection.  

▪ Advance Settings: Enables the Calibration settings portion of 

the Signal tab, if applicable. It is not recommended to make any 

adjustments to these settings without the assistance of an 

Erbessd Instruments support engineer, as changes to these 

settings will affect the accuracy of connected interfaces. 
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Channels Tab  

 

The Channels tab is used to specify sensor Type and 

Sensitivity for up to 4 channels.  

 

NOTE: Sensitivity, Type and Trigger controls are inactive until 

a channel is selected. Channel 3 is inactive with the wired GX-

400 interface, unless the optional splitter cable is used.  

 

▪ Sensitivity: Specifies the sensitivity for the installed 

sensor. Unless specialty accelerometers are specified, all 

Erbessd Industries accelerometer device sensitivity is 

100 mV/g. The Laser Optical Sensor sensitivity is 130 

mV/g.     

▪ Type: Identifies whether the sensor is an Accelerometer, 

Velocimeter, Proximity Probe or Optical Sensor  

▪ Trigger: Toggles default vibration trigger setting 

between Active or Inactive (portable instruments only).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Other Tab  

 

Allows the Phantom menu to be displayed or hidden, as desired. 

It can also enable or disable the alarms for: 

-Last connection 

-Battery 

-Temperature 
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Specify USB or Wi-Fi Connected Interface (Portable Instruments Only)  

 

At the current time, all Erbessd Instruments portable instruments except WiSER3x require USB Connection.  

 

 
 

 

To use the WiSER3x with DigivibeMX, click to change USB Connection to Wi-Fi Connection. Then, press the button on your 

WiSER3X and connect to the EIWiSER network on your computer. 

 

 

Once that you’re connected to the EIWISER network, click the “Connect Wi-Fi” button that is on the Configuration tab or in 

the Analyze tab. 

 

 

The software will let you know once your device is connected. 
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Change Language. 

  

DigivibeMX new characteristic is that now it´s multilingual. The language change can be done through the 

”Configuration” Menu with the “Change Language” button. 

 

 

This will open the language selection window. Here you will see the option to change the language of all the 

interface into Spanish, English, French and Russian.  

 

 

When changing the language the software will need to restart so it will notify when making this action and it 

will automatically restart. 
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WiSER VIBE Connection. 

  

DigivibeMX now allows to create a direct connection and share information through the WiSER VIBE app. With 

the “Connect to WiSERVibe” button it’s possible to transfer all of the recordings storage on your iOS device.  

 

 

Pressing this button will generate a QR code from DigivibeMX and with WiSER VIBE, with the option “QR 

Connect”, scan the code. 

 

                     

When scanning the code the link between DigivibeMX and WiSER VIBE is created and in the main window will 

appear a “Connected” notification. Now all of the information stored on your iOS device will be available on 

DigivibeMX. 
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In the “Device” window you can find the next buttons: 

 

 

• Connect: Generate a new QR code to connect to DigivibeMX through WiSER VIBE. 

• Refresh: Updates de list with information on screen. 

• Download selected files: Allows to download selected recordings from the list to an .anl file. 

• Download to database: Allows to download selected recordings from the list directly to a point in the 

database. 

• Add route: Allows you to add routes from DigivibeMX to WiSER VIBE. 
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Navigating DigivibeMX® Software 

User Interface 

DigivibeMX® version 11 has maintained a classic Windows-style appearance. The software is still organized by Menus. 

Each Menu still features toolbars with control buttons. However, DigivibeMX® version 11 has been specifically redesigned 

to be more portable and touchscreen friendly than previous versions.  

 

The User Interface is divided into 3 main sections: 

• Section 1: Menus and Toolbars 

• Section 2: Data Tree and Shortcut Tabs (Start Menu) / Signal Values (Analysis Menu – M20, M30, Phantom) 

• Section 3: Quick-launch Tiles (Start Menu) / Analysis and Work Area for other software functions   

 

Depending upon computer screen resolution, all Quick-launch Tiles displayed here may not be visible. The entire panel 

may be scrolled laterally to view tiles. If using a mouse, roll the scroll wheel or click and drag the panel. On touchscreen 

devices, simply slide the panel with your finger. Tiles may be rearranged as desired.  

Also, some tiles above may not be available, depending upon the software model purchased. For example: The above 

image represents M30 software with all available features. M10 does not have Database, Vibration Analysis, Routes or ODS 

features. M20 Does not have Dynamic Balancing features. Phantom does not have Dynamic Balancing or Route features. 

 

 

 

1 

2 

3 
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Menus and Modules 

The graphic user interface of DigivibeMX® Version 11 has been completely redesigned with more intuitive menu options, 

increased touchscreen compatibility and easier access to functions. Key operations such as Dynamic Balancing and Route 

Data Collection now launch in separate modules. Certain menus and modules may not be available, depending upon the 

software model purchased. 

MENU M10 M20 M30 PHANTOM 

File Manager √ √ √ √ 

Start menu √ √ √ √ 

Data Base menu --- √ √ √ 

Analyze menu √ √ √ √ 

Functions menu --- √ √ √ 

Alarms menu --- √ √ √ 

3D (ODS) menu --- √ √ --- 

Phantom menu --- --- √ √ 

Tools menu √ √ √ √ 

Configuration menu √ √ √ √ 

Help menu √ √ √ √ 

Balancing module √ --- √ --- 

Routes module --- √ √ --- 

 

File Manager                    (All Digivibe Models) 

The File Manager button opens File Manager options to: 

• Launch one of several New common tasks 

• Open a recorded file or database 

• Save an off-Route vibration recording – into the current database or as an independent file.  
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Start Menu (All Digivibe Models) 

 

Options and control buttons on the Start Menu will vary depending on the software model purchased. The picture below 

represents M30 with all available features.  

 

 
 

 Measure toolbar 

▪ New Analysis: Starts a new off-Route Vibration Analysis recording session. Opens the Analysis Menu and 

Waveform/FFT window in the Analysis and Work Area (M20, M30) 

▪ Open: Opens a File Explorer window for navigating to and opening a saved Vibration Analysis recording file 

(All DigivibeMX models) 

▪ Multiple File Selection: Allows you to select measurements from any machine so you can open it on 

different channels on the same plot. 

▪ New Balance: Starts a new Dynamic Balancing session and launches the Balancing module (M10, M30) 

Balancing toolbar (M10, M30) 

▪ In Situ: Allows balancing in 1 or 2 planes using the method of influence coefficients. (M10) 

▪ SBS: Access the balancing wizard to work with your soft bearing suspensions. (M10) 

Routes toolbar (M20, M30) 

▪ New Route: Launches the Route creation window. Used to create new Vibration Analysis Routes from 

available machines in the current database 

▪ Start Route: Launches the Route data collection module. Used load and collect an existing Vibration 

Analysis Routes for machines in the current database 

▪ Quick Route: Allows the collection of a route without previously modifying it or creating a name and group.  

▪ Code Route: Launches the Route to collect an existing Vibration Analysis Route by scanning machine 

barcodes assigned in DigivibeMX 

▪ New Schedule: Launches the Schedule window to create a new programed route in a specific period of 

time. 

▪ Route Compliance: Launches the graph compliance windows where the information of the routes taken 

and not taken is shown. 

EI-Analytics toolbar 

▪ Login: Opens the Login window for EI-Analytics (subscription service) 

▪ Logout: Logs out of EI-Analytics (subscription service) 

Machines toolbar 

▪ New Machine: Creates a new Machine in the database (M20, M30, Phantom) 

▪ ODS: Starts a 3D ODS simulation session. (M20, M30, Phantom) 

▪ Real ODS: Starts an off-route 3D ODS simulation session. (M20, M30, Phantom) 

Reports toolbar (All DigivibeMX models) 

▪ New Report: Launches the Reports module  

▪ Trends: Opens the statistical data Dashboard window for the current database in the Analysis and Work 

Area (M20, M30, Phantom) 

Help toolbar (All DigivibeMX models) 

▪ Index: Opens a link to the Erbessd Instruments user manual. 

▪ Online Help: TeamViewer QuickSupport download link, allowing Erbessd Instruments technical support 

engineers to assist via remote access. 

▪ Video Tutorials: Opens a link to the Erbessd Instruments Youtube channel. 
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Data Base Menu (M20, M30, Phantom) 

 
 

 Machine toolbar 

▪ Machine Manager: Opens the creation window for a new machine in the current Database, allows to Edit 

and Delete elements within the machine tree structure. 

▪ Notes: Opens a window to create a tool-tip style note at the machine or point level in the database 

Connection toolbar 

▪ New: Opens a File Manager window to create a new SQL database 

▪ Connect: Connects DigivibeMX to a different SQL, SQLCe or MySQL database 

▪ Refresh: Updates the database with the latest changes made 

Synchronize toolbar 

▪ Synchronize: Allows transferring data from one database to another, from a local database to a cloud based 

database or vice versa. 

EI-Analytics toolbar 

▪ Login: Opens the Login window for EI-Analytics (subscription service) 

▪ Logout: Logs out of EI-Analytics (subscription service) 

Tools toolbar 

▪ Explore: Opens a window to Explore the SQL database tables* 

▪ Utilities: Opens a toolbar with options to Update a database version, Repair a database, Compact a 

database, or Open the database importer. 

▪ Database Size: Calculates the size of your current database. 

▪ Delete Measures: Delete Manager tool that allows to remove information of the database in a selected 

time period. 

 

*Do not use this feature unless you have knowledge on SQL databases.  
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Analyze Menu (All DigivibeMX Models) 

 

 
 

Measure toolbar 

▪ Record: Starts a manual off-route data recording 

▪ Stop: Ends a manual off-route data recording or live, real-time recording 

▪ Real Time: Starts a live, real-time recording 

▪ Trigger: Sets a recording to begin when the preset Trigger vibration threshold is reached 

Sound toolbar 

▪ Play icon: Plays the audio of a displayed vibration data collection 

▪ Stop icon: Ends audio playback of a displayed vibration data collection 

Channels toolbar 

▪ Channels: Selects the number of channels to record for an off-route data collection 

▪ Add Channel: Adds another channel of data from the database or external file for comparison 

▪ Delete: Removes one channel of data from de database. 

Parameters tools 

▪ Window: Allow the user choose between the 8 FFT configurations 

▪ Units: Allow the user change the amplitude units for the FFT and TWF  

▪ Frequency: Allow the user to change the frequency of FFT (CPM, Hz Orders) 

▪ 50K: Allows the user to change the displayed unit scale of the CPM graph. You can choose between 10K, 

30K, 50K, 100K and 300K.  

▪ Save Personal Configuration: Allows to save specific set up defined by user for the type of units, zoom, 

windowing for the TWF and FFT. 

▪ Remove Personal Configuration: Deletes the set up previously defined by the user and configures de 

default options. 

Markers toolbar 

▪ Notes: Opens the window to create a tool-tip style note 

▪ Marker: Allows the user to place custom markers on the Time Waveform or FFT 

▪ Clear: Clears all markers from the Time Waveform or FFT 

Common Markers toolbar 

▪ Save: Saves all markers placed on the Time Waveform or FFT to be recalled later for other signals 

▪ Load: Loads previously saved common markers to be displayed on the signal 

Specific Markers toolbar 

▪ Save: Saves all markers placed on the Time Waveform or FFT to the currently viewed signal only 

▪ Load: Loads previously saved specific markers to be displayed on the signal 

Visualization toolbar 

▪ Visible legends: Allows you to remove the data displayed to the right of the open signals. 

Scopes toolbar 

▪ Panelized: Allows to distribute the different channels on separate scopes. 

▪ Range Selector: Graph that shows the whole spectrum for both scopes (FFT and TWF) and lets you define 

the range of data shown in the main scope. 

▪ Visible Legends: Remove/Show the information presented in the square on the right of the scope. 

FFT Tools toolbar 

▪ Harmonics: Displays 1 – 10 harmonic marker lines from a selected point in the FFT 

▪ Sidebands: Displays 1 - 4 sideband marker lines from a selected point in the FFT 

▪ Averages: Recalculates the FFT using up to 10 averages (default view is 1) 

▪ Overlap: Allows the user to overlap the FFT up to 90 times 
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▪ Decibels: Displays the FFT in Db amplitude 

FFT Distance toolbars 

▪ Horizontal: Allows the user to measure between two points horizontally in the FFT 

▪ Vertical: Allows the user to measure between two points vertically in the FFT 

TWF toolbar 

▪ Transient: Displays interval sideband markers from a selected point in the Time Waveform  

▪ Circular TWF: Displays the Time Waveform in a circular pattern based on a selected frequency 

TWF Distance toolbars 

▪ Horizontal: Allows the user to measure between two points horizontally in the TWF 

▪ Vertical: Allows the user to measure between two points vertically in the TWF 

 

 

 

Functions Menu (M20, M30, Phantom) 

 

NOTE: The Functions Menu contains tools for advanced Time Waveform and FFT analysis. A recorded signal should be 

opened for analysis before proceeding to the Functions Menu.  

 

  
 

 Single Channel Functions toolbar 

▪ Circular TWF: Displays the Time Waveform in a circular pattern based on a selected frequency 

▪ Waterfall: Displays a cascading 3D FFT representation of the vibration signal 

▪ Spectrogram: Color representation of signal amplitude 

▪ Frequency 0: Frequency calculation based on the time elapsed between crossings of 0 axis 

▪ FFT: Amplified frequency spectrum 

Dual Channel Functions toolbar 

▪ Bode: Bode chart for calculating resonant frequencies 

▪ Phase: Graphic that represents the Phase in each frequency of the whole spectrum 

▪ Cross: 2 signal crossing function to weight matching frequencies 

▪ FRF (Frequency Response Function): Measures the output spectrum of a system in response to a stimulus 

▪ Coherence: Statistics to examine the relationship between 2 data collections 

▪ Orbit: Dynamic 2D representation of rotor shaft displacement 

▪ Cascade: Displays a 3D cascade graph of several waveforms or FFTs (highlight multiple desired readings in 

the Historic Measures screen to activate Cascade) 
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Alarms Menu (M20, M30, Phantom) 

 

NOTE: The Alarms Menu contains tools for setting envelope alarms around the FFT of a recorded signal. The desired 

recording should be opened before proceeding to the Alarms Menu.  

 

 
 

 Show Alarms toolbar 

▪ Show All Alarms: Displays all envelope alarms set on the current recording (if any) 

▪ Green: Displays or hides the lowest level alarm envelope 

▪ Yellow: Displays or hides the mid-level alarm envelope 

▪ Red: Displays or hides the highest level alarm envelope 

Configuration toolbar 

▪ Report: Displays alarm levels set at each monitoring point and axis on the machine to which the current 

recording belongs 

▪ Set Alarms: Uses the current recording’s FFT to set envelope alarm parameters that will be applied to each 

recording at that monitoring point (select Set Alarms, click Wizard) 
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3D Menu (M20, M30, Phantom) 

 
 

 Create toolbar 

▪ ODS: Opens the 3D ODS simulation Control Panel for a selected machine in the database (select ODS 

configured machine from the database, select 3D Menu, select ODS) 

Play ODS toolbar 

▪ Play: Starts movement of the 3D ODS simulation 

▪ Pause: Pauses the simulation 

▪ Stop: Stops the simulation 

Speed toolbar 

▪ Down: Decreases the simulation speed 

▪ Up: Increases the simulation speed 

Amplitude toolbar 

▪ Decrease: Decreases amplitude of the simulation movement 

▪ Amplify: Increases amplitude of the simulation movement 

Tools toolbar 

▪ Copy: Export the 3D ODS simulation as a still image file 

▪ GIF: Export the 3D ODS simulation as a moving GIF file 

 

NOTE: For detailed instructions about using 3D ODS functions, please refer to Page 128. 
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Phantom Menu (M30, Phantom) 

 

 
 

Phantom toolbar 

▪ Wizard: Opens the Phantom Configuration Wizard 

▪ Status: Opens the Phantom status window to view a Phantom sensor’s current state 

▪ Signal Strength: Displays a list of sensors connected to the Gateway. By selecting a sensor, it shows the 

signal strength for that specific sensor. 

▪ Add GPIO Sensor: Opens the Sensors for GPIO window. In this window you can set accelerometers, 

proximeters and velocimeters. 

▪ Power Off Configurations: Allows to set an activity period for sensors with machines that do not met a 

required value. 

▪ Alarms Set Up: Creates an alarm value for collected data. 

 

Tools Menu (All DigivibeMX Models) 

 

 
 

 Severities toolbar 

▪ ISO 10816: Opens the ISO 10816 machine vibration severity chart (velocity units) 

▪ Envelope: Opens the acceleration enveloping machine vibration severity chart (acceleration units) 

Bearings & Gearboxes 

▪ Add Bearing: Allows you to add a custom bearing and save it in the bearing library. 

▪ Bearings Info: Opens the bearing database. 

▪ Add Gearbox: Creates available gearboxes to add through the Analysis menu. 

▪ Gear Frequency: Opens the gear frequency calculator. 

Extras toolbar 

▪ Print Machine Codes: Opens the QR Code generation window to create and print QR Code labels 

▪ 3D Model Editor: Opens the 3D ODS Control Panel for editing or importing 3D ODS models 

▪ Advance Tendency: Opens the Dashboard tab to show an overview of the overall machine´s health with 

severity indicators. 

Exports and Imports Tool 

▪ Exports: Allows to convert and save any currently opened signal into any of the file extensions UFF58, ASCII 

y CSV. 

▪ Imports: Allows to transfer any file extensions UFF58, ASCII y CSV into DigivibeMX. 
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Configuration Menu (All DigivibeMX Models) 

 

 
 

 Settings toolbar 

▪ Preferences: Configures DigivibeMX® software and hardware for balancing and/or data collection 

▪ Change Language: Changes the language of DigivibeMX interface. 

Device toolbar 

▪ Calibration: Calibrates the software using the calibration device and 2/4 Channel interface 

▪ Select Device: Used to verify and select a connected interface 

▪ USB Connection: Toggles Digivibe input sources between USB-connection devices                

and Wi-Fi-connection devices (WiSer3x)  

 

 
Help Menu (All DigivibeMX Models) 

 

 Digivibe Update software toolbar 

▪ Check for Updates: Checks the Erbessd Instruments server for updated software versions. DigivibeMX v11 

updates can be performed immediately or downloaded for later installation. 

▪ Release Notes: Automatically downloads the latest release notes document where the recent updates will 

be detailed. 

             Monitoring Service Update software toolbar 

▪ Check for Updates: Checks the Erbessd Instruments server for updated EI Monitoring software versions.  

Help toolbar 

▪ Help Index: Opens a link to the Erbessd Instruments user manual. 

▪ Online Help: Opens a link to download TeamViewer QuickSupport for online remote support 

▪ Video Tutorials: Redirects to the YouTube page where you can find video tutorials for Erbessd Instruments 

devices. 

www toolbar 

▪ Erbessd Instruments: Opens a web browser linked to the Erbessd Instruments website 

▪ EI Analytic: Opens a web browser linked to the EI-Analytic homepage 

Activation toolbar 

▪ Activation: Opens the software activation window 

▪ About: Displays software version and copyright information 

View Options toolbar 

▪ View Options: Changes the screen appearance and coloring of DigivibeMX software for easier viewing in 

high light, low light or other conditions which might otherwise make viewing difficult.  

▪  
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Routes Module (M20, M30) 

The Routes module is activated by selecting New Route, Start Route, Quick Route or Code Route on the Start menu 

 

 
 

 

 

 

 

 

Selecting New Route launches the window to create a new vibration data 

collection route from machines in the current database, before proceeding 

to the Routes module. 

 

 

 

 

 

Selecting Start Route launches the Routes module immediately.  

Load an existing vibration data collection route to begin collecting data. 

 

 

 

 

 

 

 

Selecting Code Route launches the QR Code scanning window. Scanning a 

machine QR code opens the scanned machine in the Routes module for 

immediate data collection.  

 

 

 

 

 

 

Selecting Quick Route will display a notification and checkboxes will appear 

in the machine tree. Here, we can select those machines that we need for a 

fast route with predefined capture values. Clicking Ok will open the route 

wizard you know in “Start Route” 
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Balancing Module (M10, M30) 

 

The Balancing module in versions M10 and M30 is opened by selecting New Balance on the Start menu, then selecting 

whether to perform: 

▪ Soft Bearing Suspension (SBS) balancing on a soft bearing suspension balancing stand, or…  

▪ Influence Coefficients balancing on an assembled machine or hard bearing stand 

 

 
 

Balancing with Influence Coefficients 

(In Situ) 

 

 

 

When a new balancing session is started via the 

In Situ button, the balancing window opens 

automatically. It contains, together with the 

polar plots, what is necessary to perform any 

dynamic balancing. In this window you can see 

two polar plots for balancing in two planes. The 

right graph can be activated or deactivated 

with the button depending on your needs. 

 

 

 

 

•       Record: Starts vibration and phase data collection. 

•       Stop: Stops vibration and phase data collection. 

•       Planes: Allows to activate the collection in 1 or 2 planes. It also allows to access the balancing wizard. 

•       Configuration: Allows to change balancing options such as direction of rotor rotation, units, etc. 

•       Connection type: Choose whether the data recording will be with a device connected via USB or WiFi. 

•       Calculator: Allows to choose options for weight division, test weight calculator, drilling, etc. 

•       FFT: Opens a window showing the FFT and TWF of the current measurement. 

•       Generate Report: Allows you to create a balancing report in PDF, DOC, XLS, etc. 

•       Show Tachometer: Opens a window that shows the RPM counter of the optical sensor. 

•       Split Masses: Opens a window that allows you to split the correction weights at different locations on the 

rotor. 
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Balancing with Soft Bearing Suspensions (SBS). 

When you start a new balancing session via the SBS method, the balancing wizard window will open. This window allows 

you to configure the settings of your rotor with respect to the balancing machine or SBS of Erbessd Instruments. 

 

 

 

 

 

 

 

In this window you can perform the following: 

• Select the type of mounting (centered, lateral, cantilever, etc.) in the upper center schematics.. 

• Enter the dimensions requested in the schematic drawing. 

• Select the units in which the measurements are placed on the schematic. 

• Enter the weight of the rotor in kg. 

• Select the desired quality grade. 

• Select the nominal working speed of the rotor (not the speed at which you will balance the rotor). 

• Select whether to add or remove correction mass for balancing. 

• Write the coefficient of the soft bearing suspensions according to the one you acquired. 

• Saves different configurations/schemes within the software for repetitive balancing jobs. 

Finally, at the bottom of the window we find a preview of the rotor to be balanced. It is important to take into account this 

image because it should resemble our rotor to be balanced, so that if there is any error in the dimensions indicated in this 

image we will notice it quickly. 

The schematic diagram shows graphic elements described below: 

• Big blue circle: Placement site of the mass in plane 1. 

• Big green circle: Placement site of the mass in plane 2. 

• Red dot: Center of gravity. 

• Blue dot: Center of percussion* of the mass placement site in plane 1. 

• Green dot: Center of percussion* of the mass placement site in plane 2. 

• Red rectangles: Supporting points, in this case the floating bases. 

* The centers of percussion are the centers of rotation if the element is excited at its point of mass placement. These 

centers are the axis of the calculation of the influence coefficients.. 
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Using DigivibeMX® Software 

DigivibeMX® is a powerful and versatile Condition Monitoring software. It empowers users with industry-leading vibration 

analysis and dynamic balancing capabilities. New tasks open in one of two ways: 

▪ In a tabbed window of the Analysis and Work Area, which allows switching between several tasks in progress. 

Individual tabs can be closed when tasks are complete.  

▪ As a separate module of the software, which can be closed when the task is complete (Route data collection and 

Balancing functions)  

Start Tab 

Features large quick-launch tiles to make selecting and launching key functions easier in a tablet computer environment. 

The pane can be scrolled horizontally by holding the mouse left-click button and dragging the screen, by rolling the 

mouse scroll wheel, or with a finger slide on touchscreens. Tiles may be rearranged as desired.     
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Start screen tiles 

Open Files tile (M20, M30, Phantom) - Opens the Historic Measures tab, which allows selection of vibration data 

recordings from the database for analysis. 

  

 

 

 

 

Tendency tile (M20, M30, Phantom) - Opens the Dashboard Tendency tab, which allows trending of vibration data 

from the database in real values (acceleration, velocity, displacement, acceleration enveloping) or severity (score).  

   

NEW!!! Extra Parameters tile (M30, Phantom) – Opens the Historic Extra Parameter, which allow to see the 

historical measures like RPM, Current, Temperature or GPIO. 

  

  



 
 

31 
Erbessd Instruments – DigivibeMX 11.50 noviembre 2022 

Analysis tile (M20, M30) - Opens the Analysis tab for collecting and analyzing off-route data. 

 

 

 

 

 

 

 

 

Route (Open) tile (M20, M30) - Opens the Route module for loading and collecting an existing route.  

 

 

 

 

 

 

 

Routes Manager tile (M20, M30) - Opens the Routes window for creating new vibration data collection routes from 

machines in the current database.  
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Barcode tile (M20, M30) - Opens the Barcode reader. A scanned machine then opens in the Route module for 

vibration data collection.  

 

 

 

 

 

 

 

 

ODS tile (M20, M30) – Selecting a 3D-model assigned machine from the database, then selecting the ODS tile opens 

the machine in the ODS control panel.  
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Balancing single plane tile (M10, M30) – Opens the Balancing module to perform a single-plane balance.  

  

 

 

Balancing 2 planes tile (M10, M30) – Opens the Balancing module to perform a 2-plane balance.  
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Left-Hand Panel and Shortcut Tabs 

The left-hand panel provides information related to the current database or tasks in progress. It also features two shortcut 

tabs, allowing quick transition between viewing the Database and Analysis tasks in progress.  
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Database Tab  

The Database Tab provides navigation within the currently-opened 

database - a file and folder system where all collected data is 

stored. The DigivibeMX® database system is compatible with SQL, 

MySQL, SQLCe file formats. For specific Data Base Menu features 

and functions, please refer to the “Using the Data Base Menu" 

section on Pg 46. 

 

Database folders and files are displayed in a standard tree format. 

Database hierarchy is as follows: 

- Highest Level: Company Name, Customer Name or Plant 

Location (for service providers or other users collecting 
data in multiple plant locations) 

- Second Level: Production or Process Area 

- Machine Level: Machine ID 

- Measurement Point: Bearing or measurement location 

- Measurement Axis: H (horizontal), V (vertical), A (axial) or 

R (reference channel for ODS rendering) 
If Machine Alarms are used, each level of the database will display 

the highest severity alarm for any collected data it contains.  

 

NOTE: Right clicking on items in the Database opens a context 

menu. Active options available from the menu will depend upon the 

level of the item selected. Configure and Duplicate options are only 

available at the Machine Level. 

 

The  button unpins the left-hand panel from its default 

location. The panel can be moved to the right-hand side of the 

Digivibe screen, stacked above, below or hidden. Click and hold 

the unpinned panel and drag toward the center of the screen. An 

orientation diagram appears. Drag the panel to the new desired 

position on the diagram. 
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Analysis Tab (M20, M30) 

 

 

 

The Analysis tab opens the telemetry panel for Vibration 

Analysis and Off-Route data collection. Up to 4 channels 

of data may be simultaneously displayed and compared. 

 

The Analysis panel has 2 information tabs: Values and 

Analysis.  

 

The Values information tab displays the following values 

of collected vibration data for each channel. 

 

- RMS: Root Mean Square of overall vibration.  

- Max: Maximum amplitude FFT peak. 

- Max Freq: Frequency of highest FFT vibration peak. 

- Peak to Peak: Amplitude of the waveform from its 

highest to lowest peak. 

- Crest Factor: Compares how close the waveform is to a 

pure sinusoidal waveform value of 1.414. 

 

The  button hides the displayed information 

 

The  button restores the hidden information 
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Analysis Tab continued (M20, M30) 

 
 

 

 

 

   

  

The Analysis information tab features several key functions 

for quickly analyzing common concerns.  

 

– Reference Channel button: Used to select the channel 

to which analysis functions will be applied. 

- Frequency and Arrow buttons: Used to select or specify 

the desired fundamental frequency to compare relative 

phase or calculate bearing and gear fault frequencies. 

 

- Markers: Places markers on the FFT spectrum for the 

Max, Max 5 or Max 10 frequencies, as desired. 

 
- Phase: Shows the relative phase comparison for all 

channels open for analysis (up to 4). 

 
- Bearings & Gearboxes: Displays bearing and gearbox 

fault frequencies assigned during machine building in the 

database. If none are assigned, they may be added using 

the Bearing and Gearboxes tools.   

 
- Values Field: Displays values for the specified Markers, 

Phase, or Bearing & Gearbox calculations.  

- Clear list: Clears data from the Values Field 

- Delete last: Deletes the last value calculated from the 

Values Field. 

- Draw: Places corresponding markers on the FFT spectrum 

for values displayed in the Values Field 



 
 

38 
Erbessd Instruments – DigivibeMX 11.50 noviembre 2022 

Analysis and Work Area  

 

The Start screen, new tasks and functions open as tabbed windows in the Analysis and Work Area.  

 

This format allows users to easily switch between various tasks in progress. When a certain task or function is no longer 

required, its tab may simply be closed. The only exceptions are Dynamic Balancing and Route Data Collection functions, 

which open separately in their own independent software modules.  
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Historic Measures window (M20, M30, Phantom) 

On the Start tab, select the Open Files tile to open the Historic Measures window.  

 

Selecting the Plant level in the data tree displays the most severe data collection for each area in the Plant. 

 

Selecting the Area level in the data tree displays the most severe data collection for each for each machine in that Area. 

 

Selecting the Machine level in the data tree displays the most recent collections at each point and axis for that machine. 

Select View File to open a data collection’s Time Waveform and FFT in the Analyze window. 
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Historic Measures window continued (M20, M30, Phantom) 

Selecting the Point level in the data tree displays the most recent collections at each axis for that point. Select View File to 

open a data collection’s Time Waveform and FFT in the Analyze window. 

 

Selecting the Axis level in the data tree displays all historical collections at that axis. Select View File to open a data 

collection’s Time Waveform and FFT in the Analyze window. 

 

To view the file path where the current database is located, hover the cursor over the left-hand Database tab. 
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Historic Measures window continued (M20, M30, Phantom) 

To open multiple readings in a cascade plot, highlight the desired readings (drag down the list or Ctrl+click to select desired 

rows) and select the Cascade icon. The Copy button copies data from highlighted cells to paste into Excel, Word, etc.  

The Delete button deletes highlighted cells from the database.  

 

 
 

 

 

 

 

 

 

 

 

Mode: Select between rendering 

the TWF, FFT or you can choose 

Trend option to see the trends 

for the chosen points..  

Settings:  

- Increase or decrease zoom on 

the X or Y axis. 

- Switch between 2D or 3D view. 

- Toggle point name labels 

on/off 

- Toggle severity indication 

on/off 

- Toggle filter on/off 

- Select amplitude units to 

display.  

The check boxes can be used to 

display or hide selected 

recordings. 

Use the Copy button to copy the 

cascade plot to the computer 

clipboard and paste into a Word 

document, email, etc. 
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Internal RMS (M20, M30, Phantom) 

 
 
This new DigivibeMX 11 feature allows you to visualize the RMS information of your signals. To access to this data, you have 

to locate yourself in the tree within an axis and then press the “Show Internal RMS” button. At the end of the list all of the 

RMS information will appear. 

 

 
 
This feature it’s only available from DigivibeMX 11.32 and EI Monitoring Service 1.24 and above.  

 

The RMS information is also graphed in the Tendency window, it’s important to click on the axis and then press the “Show 

Internal RMS” button and the information will be displayed. 
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Octave Bands (M20, M30, Phantom) 

 

 
 
This DigivibeMX 11 feature allows you to perform and even greater vibration analysis creating an Octave Bands graph. When 

pressing on an axis, you can choose any listed signal and press the “Octave Bands” button. To add more signals to the graph, 

select the files from the list and then press the “Add Measures” button and if you want to delete signals from the graph, 

press the “Remove Measures” button. 

 

 
 

The previous buttons control the information shown on the “Octave Bands” window; with the buttons located on the upper 

left corner you can choose between showing Velocity or Envelope Acceleration information. You can also change the type 

of graph plotted; a bar or a line graph. 
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Open Multiple Files (M20, M30, Phantom) 

 

 
 
This new feature allows you to open more than one file at a time for you to see the FFT and TWF. You can open a maximum 
of 4 files at a time, however in the future (with new updates) it could be more. You can even combine this feature with 
the multiple file selection to open files on another point or machine. 
 

 
 
You will see that the name of the graph is now “Multiple Signals”, meaning that the files open were used with this tool. 
Now you can start working with your measurements quicker. 
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Multiple File Selection (M20, M30, Phantom) 

 

 
 
This tool allows you to show more information on the Historic Measures list; even if this information is on another axis. 
This way you can open files at the same time without having to first open a signal and then adding the channels 
individually. 
 

 

 
Clicking the button will change the tree into a multiple selection row, check one of the boxes to show it on the Historic 
Measures list. Check another box to add more measurements to the list and then use the Ctrl button to select 
measurements and then the “Open Multiple Files” button to open the files in the same graph as different channels. 
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Extra Parameters Window (M20, M30, Phantom) 

 
On the Start tab, select the Extra Parameters tile to open the Historic Extra Parameters 

window.  

 

This window will allow you to access information from all parameters with the exception for vibration. Select the level 

where your sensor is placed and immediately you will see a button with the type of sensor: 

 

This button will show the information on a list. Remember that more than one sensor can be set in a machine or point. 

That means that you might have more than one button available to press but only one can show information at the same 

time. 

 

Depending on the sensor added to your database you will see different options and information. In the case of the above 

image; you will see the ‘Thermal Camera’ data (available on 11.37 and above). This sensor will allow you to open an image 

taken by the thermographic camera. Other type of sensors like current, temperature and general purpose will only show 

the value collected by the sensor. 
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Dashboard Tendency window (M20, M30, Phantom) 
 

On the Start tab, select the Tendency tile to open the Dashboard Tendency window. 

 

 

The Dashboard Tendency window features four panels of machine data trending information. The trending information 

displayed is determined by the database level and date range selected. Displayed information in each of the four panels is 

determined by the alarms set (displacement, velocity, acceleration and acceleration enveloping). Click on the desired 

values in each panel to instantly re-render the graph according to score (severity), vibration amplitude or hidden from 

view. Moving the cursor across a graph produces a cursor line for specific point information.   

▪ Behavior Over Time panel – Displays a trend line of highest values of the day for children under the selected 

parent level of database, for the date range selected. Left/Right chart scales correspond to values selected. 

▪ Parameters panel – Chart display of the last recorded measurement for the database level selected. Left/Right chart 

scales correspond to the nearest value displayed. 

▪ Time of the Day panel – Displays the highest severity or amplitude collection on the indicated day and time. The 

blue bars indicate data collections. Higher score or amplitude recordings appear darker. Hovering the cursor over a 

blue bar displays the corresponding value. 

▪ Children panel – Displays the last recording values for children under the parent database level selected. 

 

The buttons on the upper right corner control the visualization of the information observed in the tab. Information can be 

obtained from a specific date range or one determined by the software. The second button allows to maximize the 

information shown on every section of the trends tab and this way have a full screen visualization. 
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For the “Behavior over time” it’s possible to choose what information to show and which one to hide only by clicking the 

parameter that you want to show/hide. 

When checking vibration information is possible to visualize the FFT trough the same screen choosing the point to observe 

inside the tendency graphs. 
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Using the Data Base Menu (M20, M30, Phantom) 

The Database Menu features tools to manage the three database types compatible with DigivibeMX® - SQL, MySQL and 

SQLCe. 

 

Options on the Database Menu include: 

• Create, edit, delete machines and add Notes 

• Create, connect to and refresh databases with recent updates 

• Login and Logout of an EI-Analytic database (with subscription) 

• Explore the data tables and database Utilities 

 

 
 

Machine Manager Tool (M20, M30, Phantom) 

“Database Management” window 

By clicking on the "Machine Management" button you will open the 

"Database Management" window. In this window you will find: 

 

Machinery Database 

• Add Machine: Allows you to create a new machine with its respective 

points, bearings, gearboxes, etc. 

• Copy Machine: Allows you to copy the same settings to a new 

machine. 

 

Edit 

• Rename: Renames an existing Company, Area or Machine. 

• Edit Machine: Change the settings of an existing machine. 

• Delete Machine: Permanently deletes a machine in the database. 

 

Machine Learning 

• Machine Learning Manager: Adds or modifies existing models for 

Machine Learning. 

• Apply Machine Learning: You will apply a Machine Learning model 

to a specific machine. 

 

Gearboxes 

• Add gearboxes: Adds new gearboxes inside the database. 

• Edit gearboxes: Allows to edit previously added gearboxes. 
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Add Machine 

In this new window you will find the sections needed to create the 

hierarchy of your database: 

 

▪ Company: The company who owns the machine 

▪ Area: The production area in which the machine is located  

▪ Name: The machine name or ID number 

▪ Image: Upload an image to your machine. 

▪ Notes: Write additional info for your machine or important notes. 

▪ Alarms: Create alarms for different parameters such as RPM, 

Temperature, Phase, etc. 

▪ Coefficient: The machine maintenance priority or criticality for 

severity trending on a 1-10 scale (1 for critical machines, 10 for 

nonessential machines) 

▪ Slope Interval: The time period to be considered for machine 

severity calculations. 

▪ Code: The unique and unrepeatable code that is generated for 

each machine. 

▪ Task: Generates tasks to generate email notifications and alerts at 

defined intervals and parameters. 

 

 

 

 

 

 

▪ Analysis Point: The number of machine monitoring points where 

data will be collected and analyzed, you can add more point with 

the green button with the symbol (+). 

▪ RPM: Speed range in which the machine normally operates. 

▪ Axis: Allows you to select which axis will be created for that point. 

You can choose up to three axis (Horizontal, Vertical and Axial). 

▪ Alarms: Allows to generate severity alarms for different 

parameters. By default, alarms are added for Velocity and Acceleration 

Envelope (according to ISO 10816). 
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Creating a New Machine in the Database continued 
 

▪ Bearing: Allows you to add bearings to the point where you are located. 

▪ Gearbox: Adds a previously created gearbox or you can also create 

one from this menu. 

▪ Machine Learning: Adds Machine Learning models at the point to 

generate customized severity alarms. 

▪ Extra: Select severity alarms for "extra" parameters such as 

temperature, current, RPM, etc. 

 

 

 

 

 

▪ Coupling: The machine coupling or drive configuration (direct, 

belts, coupled, etc.). This setting is optional, and you can store your 

machine without choosing a coupling type. 

 

 

 

Options Menu 

 

 

By clicking on the "Options" drop-down menu you will see more options for additional 

settings and functions for your machines. 

▪ Axis and Point Severity Alarms: Speed range in which the machine normally 

operates. 

▪ Bearings: Here you can find the library of bearings and assign one for your 

machine. 

▪ Add Machine Learning Model: Allows you to add Machine Learning models to the 

new machine. 

▪ Add coupling: The coupling of the machine or its pitch configuration (direct, bands, 

coupled, etc.). This option is optional, and you can save your machine without choosing 

a coupling type. 

▪ Reset Form: Returns the previous information to its default settings; including 

machine name, area and company. 
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Creating a New Machine in the Database continued 
 

Assign a Bearing to a Measurement Point 

 

DigivibeMX v11 features a Bearing database containing fault frequencies of over 40,000 common bearings from major 

manufacturers. Bearings may be permanently assigned to a machine measurement point, or specified during Analysis. The 

Bearing database features a Search function, a Manual function for adding new bearings and fault frequencies to the 

database, and a Calculator to calculate bearing fault frequencies using bearing component measurements. These last two 

are only available trough the “Tools”-> “Bearing Information” menu. 

 

 

 

 

 

  

Enter complete or partial 

(at least 4 digits) bearing 

part numbers to Search the 

database. 

Bearings can be manually 

created using calculated fault 

frequencies or those 

provided by the bearing 

manufacturer. 

The Calculator can be used to 

calculate fault frequencies using 

measurements or from data 

provided by the bearing 

manufacturer. 
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Creating a New Machine in the Database continued 
 

Assigning an Alarm Configuration to a Measuring Point 

 

Vibration alarm limits can be configured for each Measurement Point. Alarm Limits can be specified for Acceleration, 

Velocity, Displacement and/or Envelope Acceleration values, as desired. By clicking on the "Axis Severity Alarms" button 

under "Options" you can choose the axes to which you want to apply your alarms and then choose the parameter to 

measure.  

  

1- Select axis - Choose the axis to which an 

alarm will be assigned through this window. All 

points of the current machine will be displayed. 

2- Select parameters - By default there are 

values for Velocity and Acceleration Envelope 

(according to ISO 10816). You can press the (+) 

icon to add Acceleration and Displacement. 

3- Edit or add alarm values - Click on the Edit 

button to modify the displayed settings. Click 

the (+) button to add a parameter such as 

Acceleration and Displacement. 

4- Set limits - New Yellow, Orange and Red 

alarm limits can be entered manually, and their 

values adjusted with the (+), (-) buttons or with 

the bottom bar. 

5- Save the alarm (optional) - Identify your 

parameter limits and to reuse this alarm at 

another point save it with the "Save in defaults" 

button. Create a group name and the name of 

the alarm to be able to find it easily. 

 

 

 

 

 



 
 

54 
Erbessd Instruments – DigivibeMX 11.50 noviembre 2022 

Copy Machine 

This feature allows you to copy the configuration and points of a previously created machine. Just select the machine you 

want to copy and with the arrow symbol the information of that machine will be transferred. The only empty space will be 

the name of your new machine. However, it is possible to change some specific aspect of the copied settings. 

 

Rename  

This option will allow you to rename any element of the machine tree (except for the axis). Any renameable element will 

appear with the icon        next to its name.  

 

Edit Machine 

Select this option to change the configuration, alarm, bearing, etc. of a machine in your machine tree. Select the machine 

to edit with the  button. 

 

Delete Machine 

This option allows you to select an element from the machine tree and permanently delete all its information. To choose 

the element to delete, just press the button   next to its name. 

 

 

 

 



 
 

55 
Erbessd Instruments – DigivibeMX 11.50 noviembre 2022 

Task Manager 

The Tasks section allows you to customize your notifications according 

to your needs. Choose values or ranges of values on a machine to send 

notifications. 

 

 

This menu will allow you to create Tasks by 

Machine. So, in the following section you can do 

the following:  

Select Machine: Select a machine or point for 

tasking.  

Units: Select the units to be used for the tasks. 

 

 

 

 

Once you have finished assigning notifications to a machine; add the Task specific settings with the button. In this 

section you will find the following settings: 

Name: Change the name of the task.. 

Axis: Choose the axis or axes for which it will be applied. 

Units: Select the units according to the ones you have previously selected. Example: 

Square root, Maximum value, etc 

Condition: Choose the condition for which the notification about the configured value 

will be sent. Example: Greater than, equal to, etc. 

Value: Value that will indicate the sending of notifications. 

Action type: The way the notification will be sent. 

Title: Adds the message title. 

Content: Adds the message content. 

Interval: Configures the interval in which this message will be sent. Only one 

notification will be sent during the same interval even if the condition is repeated. 
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Machine Learning 

Machine Learning Manager 

 

 

New feature in DigivibeMX 11 & WiSER Vibe! 

Machine Learning will help you implement severity alarm models. The 

software will learn from the behavior of your machine with data contained 

within the database. Choose a number of days to analyze and the software 

will suggest new severity alarms based on the analyzed data. 

 

 

 

New Model 

 

Machine Learning works through models that act as templates 

to be applied at different points. These models can be 

organized through groups and with names for each one. 

 

 

 

Within the "New Model" menu you will find the 'Configurations' 

section. Here you can add parameters to your Machine Learning 

model. By default you will find Velocity and Acceleration 

Envelope. Add new parameters by pressing the (+) button. 

Then, for each parameter choose a name and the interval of days 

that the software will analyze to create its alarms. These days 

correspond to the time before the model was applied to the 

point. For example, in the image the last 30 days of this point 

will be analyzed. 
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Now choose which notifications you want to receive regarding the 

values that are generated in the Model. You can choose to have the 

software alert for the RMS, Crest Factor and Octave Bands values. 

For each of them it is possible to determine if the alert will be for 

the Yellow, Orange and Red color values. 

Note: At the moment it is only possible to receive alarms for the 

RMS value. 

 

 

 

In the next section, you can select the axis that will be affected 

by the model. By default, the three axis will be selected. 

 

The "Increment: %" section allows you to choose a percentage 

value that will be applied to the highest measurement found 

within the selected range of days.  

 

The "Offset: mm/s" section adds a fixed value in mm/s to add to 

the percentage increment in the previous section. These two 

values are added together to generate the new severity alarm. 

 

The "Minimum: mm/s" and "Maximum: mm/s" sections are 

values that the user knows are acceptable. The software takes 

this as a reference not to set alarms within this range. 

 

To delete all settings and the current parameter; press the 

"Delete" button. 
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Edit Model 

In the "Edit Model" menu you can review all the Model groups created 

to search and modify a specific model. When you choose a Model, the 

configuration window from the previous section will open. Once you are 

satisfied with the changes, click on "Create" and the changes will be 

saved for that specific model. 

Copy Model 

Copy the settings from one Model to a completely new one. This is to keep the features of one model and when creating 

a new one, make minimal modifications to it. 

Delete Model 

Delete a Model from your database completely and permanently. 

 

Apply Machine Learning 

In the "Apply Machine Learning" menu you can assign a Model 

created in the "Machine Learning Manager" menu. 

First, you have to assign the model with the bottom button 

where it says "Not set". 

This will open the list of groups where you can search for the 

Model you need. 

 

 

 

 
Once you have chosen the Model; you will be able to see the 

configuration window in case you need to make any specific 

changes. 

Now in this window you will see the option "Pick a day". With 

this option you can choose from which day the Machine 

Learning analysis interval will start analyzing the data. If left 

empty, it will take the current day as the starting point for the 

model. 

Once the configuration is ready, click on "Select" and we will be 

back in the first window. Choose the machine to which you 

want to apply the model with the button   
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Then choose which points of the machine you will apply to the 

model and press the "Calculate" button. 

 

 

 

The next window will show the calculated values according to 

the model applied to the point. The values shown can be 

modified per axis.  

Once you are satisfied with the severity alarm value click on 

"Save". 

With this, the new severity alarm will be saved to the point. 
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Assign a Gearbox. 

 

 

In this new version of DigivibeMX you can create gearboxes from the "Machine 

Administration" menu. In order to create them from this menu, follow these steps:  

 

 

▪ Select the “Add gearboxes” option. 

 

 

 

 

 

▪ Name: Name of the gearbox, ID number, serial number, etc. 

 

▪ Notes: Text field for additional descriptive information. 

 

▪ Manufacturer: Group in which the gearbox will be assigned. 

 

 

 

 

 

 

 

 

 

 

 

▪ Step name: Add the name of the first step. 

 

▪ Input: Adds the number of teeth of the input gear. 

 

▪ Output: Adds the number of teeth of the output gear. 
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Creating a New Machine in the Database continued 
 

Assign a Gearbox to a Measurement Point 

 

DigivibeMX v11 features a Gearbox tool that may be used to create and edit a comprehensive library of gearboxes. Once 

created, the gearboxes may be permanently assigned to a machine measurement point, or specified during Analysis.  

 

 

  

Create a new gearbox 

Edit an existing gearbox 

Delete a gearbox 

Groups panel: Gearboxes may be 

grouped according to function, 

manufacturer, production area, etc. 

Gearbox panel: Contains all 

gearboxes created within a selected 

group.  

Manufacturer: Group to which the 

gearbox will be assigned. 

Name: The Gearbox name, ID 

number, Serial Number, etc. 

Description: Text field for 

additional description information.  

Add a gearbox step (stage) 

Delete a gearbox step (stage) 

Bearings button: The bearings at 

each step (stage) may be selected 

from the Bearing Database. 
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Using the Data Base Menu continued (M20, M30, Phantom) 

Connection toolbar 

 

New  

 

Selecting New allows a new SQL database to be created. SQL database files can be created and saved in any location. It is 

recommended to keep all database files together in an easily-located common folder. 

 

 

Connect  

 

If database files are moved between devices or stored remotely, Connect to Database allows mapping DigivibeMX to their 

new location. 

 

Refresh  

 

Updates the database view to reflect any new data or modifications. 
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Using the Data Base Menu continued (M20, M30, Phantom) 

EI-Analytic toolbar 
 

 

Login and Logout   

 

Connects DigivibeMX to the EI-Analytic cloud-hosted database service, if activated (subscription service). For more details 

about the EI-Analytic cloud-hosted database service, please contact an Erbessd Instruments distributor, sales or technical 

support. 

 

Tools toolbar 
 

 

Explore  

 

Allows manual exploration of the database and data tables. 

 

 

Repair  

 

Database Utilities to:  

 

- Update a legacy database to the current version 

- Repair corrupted databases 

- Compact databases 

- Import updated databases 
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Using the Analyze and Functions Menus (M20, M30, Phantom)  

 

The Analyze and Functions Menus feature tools for collecting and analyzing machine vibration data. 

New off-route analysis (M20, M30) 

This type of immediate, off-route analysis with a portable instrument is not associated with any machine in the database. It 

will not be automatically saved. Off-route analysis is recommended for spot-checking, troubleshooting or other situations 

when machine vibration data must be displayed, but not necessarily saved to the database. However, off-route data 

collections can be saved by opening the File Manager and selecting Save. Files can be saved to the database under an 

existing machine. Files can also be saved outside the database as .anl files and emailed to other DigivibeMX users for review.  

 

There are two different methods for opening a new immediate, off-route data collection and analysis session:  

  

Method 1 – New Analysis on the Start Menu. 

 

 

 
 

Method 2- Analysis tile on the Start tab. 

 

Both methods open the Analyze Menu, launch the Analyze tab and switch the left-hand panel to the Analysis view. 

 

 

 

NOTE: When no interface is connected the recording control buttons will be greyed-out, as shown above.    
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New off-route analysis continued (M20, M30) 

Start/Stop Data Collection 

 

The Analysis tab launches with the default recording parameters specified in the Configuration Menu/Preferences. If 

different resolution lines or recording times are desired, changes can be made prior to recording data. Select the number 

of data channels to be collected (up to 4) from the Channels dropdown. The Time Waveform and FFT will render in real 

time as data is collected.  

 

 

Data collection is started with            and will end automatically, based on the specified Resolution Lines.  

 

 

Data collection can be stopped manually with 

 

 

To monitor a live stream of continuous data, use             to begin, then press Stop when finished.  

 

NOTE: Real Time data is not saved while monitoring. Only the information visible in the TWF and FFT can be saved, when 

the collection is stopped. To record a long TWF, set the recording time to the required duration and press Record.  

 

The           function is used in conjunction with the Trigger value specified in Configuration/Preferences/Channels tab  

 

NOTE: Press the Trigger button to prepare Digivibe for a Trigger recording. The actual recording will not begin until the 

specified Trigger vibration value is reached.   
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Viewing Vibration Data (M20, M30, Phantom) 

 

To review collected data, select the Open Files tile on the Start tab. This opens the Historic Measures tab. Select the 

desired level of data in the database. Select View File to open the recording for analysis. 

 

 

 

 

  

The selected recording opens in the Analyze Menu. To add additional channels for comparative analysis (up to 4 

channels), for dual channel analysis functions, etc: select Add Channel, then select whether to add another channel from 

the database or Browse for an external file (such as an .anl file of a data recording emailed by another user).  
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Viewing Vibration Data continued (M20, M30, Phantom) 

Selecting and Zooming: Magnifying a desired section of waveform or spectrum can be accomplished in a variety of ways. 

To select a section of the waveform or FFT for closer inspection, press and hold the left mouse button then slide it along the 

graph over the desired section to magnify. When the left mouse button is released, the selected section will be magnified. 

  

To increase/decrease zoom on only one axis, place the mouse pointer over the axis scale and roll the mouse scroll wheel. 

 

To move the graph view while zoomed, place the mouse pointer over the desired axis scale. Press and hold the left mouse 

button, then drag the axis scale up/down or left/right  

 

Floating zoom control buttons also appear automatically when the mouse pointer is positioned over an axis. 

 

NOTE: Zooming in on any section of the Time Waveform automatically re-renders the FFT, which will appear to be at 

lower resolution than the FFT of the entire waveform. 
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Time Waveform/FFT Graph tools (M20, M30, Phantom) 

A number of panel control buttons are located above each waveform/spectrum graph.  

Click to hide/display channels (more channels may appear if multiple channels are recorded or opened for 

analysis) 

Vertical measurement cursors  

 

Horizontal measurement cursors 

 

 Remove cursors 

 Clear all markers from graph 

 Clear last marker from graph 

 

Copy graph to paste into a document 

  

 Undo zoom 

 

Reset zoom 

Clear zoom 

  

 Expand panel to full screen / collapse panel back to split screen 

 

Analysis tools 

 

 

Changes the graph units between CPM, Hz and Orders.  
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Units and FFT Spectrum Windowing (M20, M30, Phantom) 

Because Erbessd Instruments technologies capture waveform data on each collection, a recording opened for analysis can 

be re-rendered immediately to suit user preferences.  

▪ Window: Hanning is usually the default windowing view for FFT spectra. Other options include: Rect, Bartlett, 

Blackman, Hamming, Kaiser, CosSum and FlatTop. 

▪ Units: Imperial and Metric amplitude units for Acceleration, Velocity and Displacement are available.  

▪ Freq: Frequency units for Hz. CPM and Orders are available. 

▪ Graph frequency limit: Sets the maximum frequency limit of the FFT graph (according to Freq units selected) 

▪ Save personal configuration: Saves all the settings chosen in the previous buttons. 

▪ Remove personal configuration: Deletes all the settings saved and restores them to default. 
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Analysis Menu Tools (M20, M30, Phantom) 

 

The Analysis Menu toolbar features essential functions for analyzing collected vibration data: 

 

Markers: Select Markers from the toolbar dropdown and click on any desired point in the FFT t o place a marker: 

 

Common Markers: May be used to save and recall markers on future recordings for the same point and axis.  

Specific Markers: May be used to save and recall markers for future analysis of the same recording. 
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Analysis Menu Tools continued (M20, M30, Phantom)  
 

Scope Tools 

This menu allows you to change the view of the classical FFT and TWF so you can work better with one or multiple 

channels at a time. 

 

The Panelized tool allows you to visualize each channel on an independent graph. It divides the TWF and FFT graphs in to 

separate graphs for each channel. 

 

The Range Selector in a different kind of zoom that allows you to define a range of time or CPM (according to the graph) 

to visualize in the scope. The Visible Legends tools hides/shows the panel with the channel information that is on the right 

side of each graph. 
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FFT Tools 

The FFT Tools dropdown menu contains several common tools for FFT analysis. 

 

 

Harmonics: Specify the number of Harmonic cursor lines desired (8 in this example), then select the vibration peak from 

which harmonics will be calculated. Blue cursor lines the harmonic frequencies appears on the graph. Use Remove 

Cursors to clear cursor lines from the graph.  
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Analysis Menu Tools continued (M20, M30, Phantom) 

 

Sidebands: Specify the number of Sideband cursor lines desired (3 in this example), then click the vibration peak to be 

analyzed for Sidebands. A blue line for each Sideband of the selected peak appears on the graph. Moving the mouse 

pointer laterally across the graph will expand/reduce the sideband spacing. When the desired sideband spacing is 

achieved, click again to freeze the sideband cursors in place. Use Remove Cursors to clear cursor lines from the graph. 
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Averages: Specify the number of averages used to produce the FFT. The default FFT view is one average. Increasing the 

number of averages reduces the appearance of random outlying peaks and periodic occurrences, showing a truer 

representation of repeating events in the FFT. However, increasing the number of averages lowers FFT resolution. 

This is the DigivibeMX® default FFT view, which is produced using 1 average: 

 

 This FFT shows the same frequency range, but was averaged 10 times: 
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Overlap: Converts and displays the Waveform in Decibels. 

 

Decibels: Converts and displays the FFT in Decibels. 
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TWF Tools 

Transient: Select Transient.  

 

Cursors window opens to the Transient tab. Click the desired frequency to analyze in the FFT. Then click the desired 

instance to inspect for transient events in the Time Waveform. Moving the mouse cursor laterally across the Time 

Waveform changes the sideband cursor frequency spacing. The sideband cursor frequency in the Cursors window 

indicates the sideband cursor spacing. (Zooming in on the affected part of the Time Waveform can help narrow down 

cursor spacing to the desired frequency interval). Use Remove Cursors to clear cursor lines from the graphs.    
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Circular TWF: Opens the Select Frequency window. Select the desired frequency from the dropdown or enter it manually. 

 

NOTE: If the Analysis view contains multiple channels, all channels will be rendered in the Circular TWF graph. 

 

 

 

The Circular TWF is rendered in a new tabbed panel, based on the selected frequency. Graph Appearance options include 

Line, Area or Points. Frequency, Start time and Cycles can all be changed after the graph is opened. Changes will be re-

rendered immediately. The Copy button allows copying the graph for pasting into a Word document, email, etc. 
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TWF Distance/FFT Distance: Calculates and displays the horizontal or vertical distance between any two selected points 

on the Time Waveform or FFT graph. Use Remove Cursors to clear marked areas from the graph. 
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Functions Menu Tools (M20, M30, Phantom) 

 

In addition to the Analysis Menu, the Functions Menu also features a number of essential tools for analyzing collected 

vibration data: The Functions Menu tools are divided between two toolbars: Single Channel functions and Dual Channel 

functions.  

 

 

Single Channel Functions toolbar 

 

The following tools are provided for single-channel analysis. 

 

Circular TWF: Explained previously on Pg. 70. (If multiple channels are opened in Analysis, all will be rendered) 

Waterfall: Produces a color-coded 3D representation of a recorded signal as both Time Waveform (0-pk) and FFT. This 

unique tool allows users to observe how frequency amplitudes in the FFT may fluctuate over time. 

  

Spectrogram: Produces a color-coded bar graph representation of vibration severity by frequency range. Interval, 

Resolution, Windowing format and Frequency units may be changed. The graph will immediately re-render. The Copy 

button copies the graph for pasting into a Word document, email, etc.  
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NOTE: Lines may initially appear very small. Zoom the view as necessary. Position the mouse pointer over the desired axis 

and scroll up/down to zoom the axis in/out. Click, hold and drag an axis in the desired direction to reposition the graph. 

 

 

 

Frequency 0: Opens a small window displaying the Cross-by-0 Frequency. 

 

 

 

 

FFT: Displays the FFT with additional dropdown options to convert between Power, Real, Imaginary and Phase views. 
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Dual Channel Functions toolbar 

 

The following tools are provided for dual-channel analysis. 

 

Bode: Displays machine start-up or run-down data collections in Bode Plot format. (Open vibration data, add speed data 

channel, select Bode, select Channel 1 for vibration – Bode plot opens. Select how you would like data to be plotted.)  
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Phase: Displays the phase angle differences between a measured point and its reference point, across the entire frequency 

spectrum. 

 

 

Cross Spectrum: Displays two channel data as a Cross Spectrum FFT graph. 
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FRF (Frequency Response Function): Displays a FFT-style graph measuring the output spectrum of a system, in response 

to a stimulus. 

 

 

 

Coherence: Displays a spectral representation showing the relationship between two signals or data sets. 
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Orbit: Displays a static or dynamic graph representing the end travel of a rotating shaft. 

 

NOTE: Orbit Analysis requires simultaneous data collection in the vertical and horizontal planes. In order to 

accomplish this, one would need triaxial, biaxial or two single-axis accelerometers. A single triaxial or biaxial 

accelerometer could be positioned vertically. With two single axis accelerometers, one must be positioned 

horizontally and the other vertically – each collected on its own channel. Start a new analysis and collect both 

channels simultaneously.  

Create an orbit plot from the data by clicking on the Orbit button         located in the Functions Menu toolbar. 

If the collected data is identified as Horizontal and Vertical, DigivibeMX can determine which channel is vertical 

and which is horizontal. 

 

In the orbit view, the duration of the drawing can be adjusted in milliseconds. The rendering speed of the 

graph can be adjusted by percentage. It is also possible to zoom in to fit an appropriate size. The image can be 

copied from DigivibeMX® with the right mouse button and pasted elsewhere as a still image. 

Observe the dynamic graph in video format by clicking the Start button. Playback can be paused and restarted 

at any point. A slider bar under the Pause and Stop buttons can be used to manually scroll through the entire 

Orbit plot. 

Below the configuration settings on the right-hand side are Filter tools that can be used to filter Low Pass, Pass 

Band, Pass High and Block Band to improve the graphical interface.  
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Alarms Menu Tools (M20, M30, Phantom) 

 

Overall alarm values for Displacement, Velocity, Acceleration and Acceleration alarms can be set for Machine Points when a 

new Machine is created in the database. These alarms are useful for ensuring that any source of vibration across the entire 

FFT spectrum will trigger a change in the Machine’s alarm status. However, due to their unique design, installation or 

functions, some machines simply do not run within normal parameters across all frequency ranges. In such cases, a user may 

want to wrap an alarm envelope around an existing “ideal state” data collection. They may also wish to reduce or increase 

alarm tolerances at certain frequency ranges. Capabilities to establish and monitor these types of customized alarms are 

provided on the Alarms Menu. To set a new alarm envelope around an existing data collection, first use Open Files and 

select View File to open the desired recording. Then proceed to the Alarms Menu.  

 

Show Alarms toolbar 

 

The following tools are provided to view or hide alarms that are set around a recording. 

Show Alarms: Displays all envelope alarms set on the open recording (if any alarms have been set).  

Green / Yellow / Red: Toggles on/off the individual Green, Yellow and Red alarm envelopes. 
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Configuration toolbar 

 

The following tools are provided to set an alarm envelope around a recording, view available alarms and provide an 

overview of the Machine’s current envelope alarm conditions. 

Report: Displays the envelope alarm status of all Points and Axis for the Machine to which the current recording belongs.  

Available Alarms: Displays the alarms that are compatible with the Machine to which the current recording belongs. 

Set Alarms: Opens the Alarms Wizard to establish or edit an envelope alarm around the displayed recording. 

 

 

Setting an alarm envelope around a recording 

 

With the desired recording open, select Set Alarms. 
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The alarm enveloping window opens, displaying the Machine and Point to which the recording is assigned. The arrow 

buttons can be used to advance to the previous or next Point in the database. Units appear as displayed in the original 

Analysis window but can be changed to alarm the recording for Displacement, Velocity, Acceleration or Acceleration 

Enveloping. To set the alarm envelope parameters, click the Wizard button to launch the Envelope Alarms Wizard. 

 

Use the Envelope Alarms Wizard to specify the increased vibration tolerance across the entire FFT Spectrum, before an 

alarm condition changes. These values may be defined by a percentage increase or an absolute value. Minimum indicates 

the amount of resulting alarm envelope from the highest amplitude documented in the enveloped recording. Checking 

the boxes displays the checked band on the Alarm Enveloping window reading. When satisfied with the overall envelope 

parameters, click Next to proceed. 

NOTE: Alarm envelopes can be adjusted at specific frequency ranges later in the process.  
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The next screen allows users to select the number of peaks to be alarmed. Indicate the desired number of peaks to alarm, 

then click Next to proceed. 

  

The next screen allows users to specify the frequency range to be included around each enveloped peak in the FFT 

Spectrum. When satisfied with the overall envelope parameters, click Finish.  
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The alarm enveloping window now displays the new envelope alarms around the FFT Spectrum.  

 

To adjust the alarm bands in specific frequency ranges, click and hold the red x on the desired alarm envelope nearest the 

beginning of the desired frequency range. Drag it to the desired frequency and amplitude, then release. Then click and 

hold the red x nearest the end of the desired frequency range and drag it to the desired location, then release. Click Save 

when finished to save the envelope alarm. 
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3D Menu Tools (M20, M30) 

 

ODS 
Operating deflection shape (ODS) Is a type of analysis capable of animating the 

deformation of a mechanical system at a selected frequency. The ODS analysis animates 

the machine’s movement at each measurement point during operation, relative to a 

common stationary point. These animations can be very useful by defining areas of 

structural weakness and identifying areas of mechanical clearance. In resonance cases, 

the ODS analysis can provide an estimate of the mode of vibration of an excited natural 

frequency.  

 

 
ODS Modeling Requires Reference Channel Data 

At the present time, Reference Channel data 

collection is only possible in Route mode, 

using portable interfaces. The Phantom 

system is not capable of collecting the 

simultaneous Reference Channel data that 

corresponds with Phantom Vibration triaxial 

or biaxial sensor data collections. 

ODS modeling data may be collected as 

part of every data collection Route, simply 

by adding simultaneous Reference Channel 

data collections to be recorded at each 

point. With Reference Channel data 

collection enabled, an extra Reference 

Channel accelerometer must be placed 

somewhere on the machine near the 

vibration data collection points. The 

Reference Channel accelerometer remains 

in place while all other machine data points 

are collected. This allows the vibration at all 

measured points to be compared with the 

stationary reference point, and therefore 

compared among themselves with the reference point acting as a constant. The Reference Channel is indicated in the 

software with the letter "R".  
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Adding a new 3D model to the database 

It is possible to add new 3D models from a local file to our database, you have to select the Machine where you want to 

add the model and click on the ODS button from the Start Menu or from the ODS tile. 

This will open the ODS window and display that the machine doesn’t have a 3D model assigned. In the New 3D Object 

window you can choose between 3D models loaded in the system (From Gallery) or a 3D model that is local based (From 

File). 

Clicking the From File button will open the file selection window for the 3D model. Choose the desired 3D model and 

click Open: 

 

Probably the most important of all 3D ODS components is the rotating cube. This cube allows rotation of the 3D model in 

any direction. Click on the cube and drag it in any desired direction to rotate the model view. Another way is to click on any 

face or edge of the cube. The figure will automatically rotate until it is in the selected position. 
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In the top menu you will find the following buttons: 

 

Displays all 3 axes. If an axis direction does not match the direction data was collected, it can be inverted. 

 

 Invert the Horizontal and Vertical axes.  

 

 Invert Horizontal and Axial Axes 

 

 Invert the Vertical and Axial axes. 

 

 Export animation to AVI video format. 

 

Export animation to GIF animated image format, this option greatly reduces file size.  

 

Export picture in static image format jpg. 

 

In the lower panel you will see the number of vibration points assigned to this image, each row corresponds to a point. You 

can see the location of each point by selecting the corresponding number. 

 

 
 

 

 

To change the axis orientation of a point or the location of the point itself you can click the "..." button and the following 

dialog box will appear. 
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Here you can invert the axis at each point by checking the Inv block.  You can also change the axis location on the model, 

add or delete information for each axis. 

 

To establish the location of the point press the "Locate" button and it will begin to change color, at this moment select a 

point directly on the figure and the location will be in the boxes corresponding to X, Y and Z. 

 

Clicking Locate on the 3D model allows you to locate the point just by clicking on the desired part of the machine. This will 

open the Point window to specify whether the point is in the center of the figure or at a selected point. 

 

Check where are the points located and placed them in the desired position selecting the number of the point you want 

to locate. 

 

Once that the 3D model and the points are set, click on the Save button. This will open the Save Clipart window, here we 

can add a Category and write a Name for the New 3D model. 
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Once that the clipart is saved in our gallery, you can use the same model for other machines with the From Gallery 

button. Using the plus button you can choose the 3D model recently created, you can find it in the Erbessd Instruments 

folder from My Documents. This way you can select the 3D model from the Category it was assigned. 
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Collecting Data for 3D Simulations (ODS) 

For 3D ODS Simulation, measurements need to 

be taken with 2 accelerometers on a data 

collection route with R reference point selected. 

Sensor 1 (single-axis or triaxial) collects data 

from all points and axes indicated by the route, 

while the 2nd sensor (single-axis) stays in the 

same reference location for all data collections. 

The reference location can be anywhere on the 

machine that vibration can be safely captured, 

without interfering with collecting route data 

points. Do not use route data collection points 

as reference points.  

Click the New Route button to open the Routes window, here you can select from all the routes in the database. 

To add a new route, click on the plus symbol button and it will open the New Route window. 
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In this window you can choose between all the assigned 

machines of the database. In the Group dropdown you can 

choose between and existing route group or create a new 

route group. In the Name box you can identify the route 

with any name. 

With the “Create Route Schedule” you can determine a 

programmed route. When you press the button you will 

open a window that allows you to program your routes daily, 

monthly, annually or in a personalized time. 

 It allows the selected machines to our new group along 

with its corresponding Points. 

 Deletes machines that were already added to the group. 

 Allows the user to change the level or priority of 

the machines added to the new route. 

In the Machine Settings menu you can choose between 

having a Reference Channel or not, choose the Resolution 

Lines from the dropdown menu, determine a Max 

Frequency, the number of averages to use and the Overlap 

percentage of the new group. 

Clicking the Ok button will open the Routes window where you can see in the boxes the new group and the machine 

assigned to that group. Select the new Route and click Ok. 
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Immediately after pressing Ok, the next window will open: 

 

In this window we can see the recorded signals from the Route and the R button to activate our Reference Channel. 
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Real ODS 

The new feature on DigivibeMX allows you to take measurements on the go and make an ODS simulation with them 

with the Real ODS tool. 

 

In the Start Menu click the “Real ODS” button to access to the Real ODS window. Here you will find the same options 

that you can find in the ODS window for route measurements.  

When selecting the “Frequencies” tab you can choose between selecting an image from the gallery or uploading a new 

image from your computer (following the steps mentioned on page 84). 

 

Once that the figure is selected for your measurement. You can add or remove measurement points with the “Points” 

tab. 
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Now that our figure and our points are set up; you can start recording your measurements in the “Recording” tab. Here 

you can find the main configuration for your recordings.  

 

 

Record: Allows you to start the recording in a selected point. 

 

Stop: Allows you to abruptly stop any active recording. 

 

Show/Hide Graph: Allows you to present or hide on screen the FFT and TWF graphs of the recording made by 

your device. 

 

Triaxial: Allows you to set the recording in three simultaneous axis. 

 

Orientation: Allows you to change the direction in which your sensor is placed. 
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Scheduled Routes 

When you save the a new route, the software will automatically ask you if you want to create a schedule for that route, if 

you choose no; then you have the chance to do it later with the “New Schedule” button. 

 

Pressing this button will open the schedule window. Here you can locate each route in the group where you have it saved. 

With the dropdown menu you can chose the scheduled frequency of the route. You can scheduled them daily, monthly, 

annually or in dates determined by the user. 

 

Once that you have selected the days or dates on which you want the route to be scheduled, click “Save”. 

To check the state of your programmed routes, press the “Route Compliance” button. 

 

This will open the graph compliance window. Here you can see all the routes grouped in three different categories 

depending on the compliance status of your route. 

 

The three status that you can find in this window are: 
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• Not taken: In this color you will find every scheduled route that are pending to measure.. 

• Monitored: This color will group every programed route that have already completed all the days of its schedule. 

• Overdue: In this color you can find every route that wasn’t taken on the day that they were programed and so they 

are delayed or overdue. 

In the lower bar you will see defined which is the next route to take today and which is the next one that hast to be taken 

indicating date and number of machines. 

When you click on any graph, you will see the machines on where that graph was made. You will see all the machines 

assigned to that route. 
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Analysis of ODS Data 

 Select the machine you want to analyze and start the ODS function:  

 

Select ODS data collection route by date and RPM.  
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Select Play to begin the ODS animation of collected data.   

 

The animation speed of the ODS model can be increased or decreased using the Down or Up controls. The effects of 

vibration can be reduced or increased with the Decrease or Amplify controls. A still image or moving .gif file can be 

copied for Word documents or emails using the Copy or GIF controls. Axis of orientation can be swapped as desired.   
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Phase Analysis of ODS Data 

 Select the Points tab and click on the Data cell of the point you want to analyze: 

 

- The phases are calculated between all points with respect to the Reference: 

- Horizontal 

- Vertical 

- Axial 

 

Subtract the phase of the point and direction that interests you with respect to the 2nd point of interest and thus obtain 

the phase between them (for example the Phase between 1H and 1V = 358 ° - 238 ° = 120 °). 

IMPORTANT: Make sure that the measurements were taken in the directions indicated in figure 3D, otherwise select the 

"Inv" box to reverse the direction at a given point (the arrow changes direction). 
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Route Data Collection (M20, M30) 

Machines in the DigivibeMX database are rarely displayed in the same order that their data would be collected. 

DigivibeMX allows Machines and Points to be grouped an organized into logical Routes that a technician would travel for 

fast, efficient data collection with portable instrument such as WiSER, WiSER3x or the GX-400 wired interface. To create a 

new data collection Route, select New Route from the Start Menu options or select the Routes Manager tile. 
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Advance Tendency (M20, M30, Phantom)  

On the Tools menu, select the Advance Tendency icon              to open the Dashboard window. 

 

The Dashboard window contains 5 panels of Severity information. Severity values provide an indication of overall machine 

health and should not be confused with the values of collected data (vibration, temperature, etc).  

Severity values are as follows: 0-1=Inoperative, 1-2=Excellent, 2-3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor    

▪ Data panel – Displays the average severity of machines or points under the database level selected, for the slope 

interval specified in machine configurations.  

▪ Severity panel – Chart display of the average severity on machines or points under the database level selected, for 

the slope interval specified in machine configurations.  

▪ Last Severities Average panel – Displays average severity based on the most recent data collection. 

▪ Severity & Slope panel -  

▪ Trending panel – Displays a severity trend for all historical readings in the database. 

The data displayed is determined by the database level selected – Company, Area, Machine or Point. Clicking the arrows 

button on any panel opens it to a full-size window view. 
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Advance Tendency continued (M20, M30, Phantom)  

Data panel 

The Data panel provides a tabled overview of machine health data for the database level selected, as follows: 

 

▪ Area: The area in which the data was collected. (When database level Company is selected) 

▪ Machine: The machine on which the data was collected. (When database level Company or Area is selected) 

▪ Point: The monitoring point where the data was collected. (When database level Area or Machine is selected) 

▪ Axis: The direction in which the data was collected. (When database level Machine or Point is selected) 

▪ Severity (Average): Average severity is calculated using the most recent RMS values collected, versus the ISO or 

User-defined alarms for the specified slope interval (days) in the machine’s Configuration. 

▪ CLE – Calculated Life Expectancy (Average)(Days): The machine’s estimated full lifespan from new. 

▪ Severity (Maximum): The maximum severity of any historical data collection at any point/axis 

▪ CLE – Calculated Life Expectancy (Minimum)(Days): The estimated days for the machine to deteriorate from green 

alarm status to red alarm status.   

▪ MTTF – Mean Time To Failure (Days): The estimated days remaining until the machine deteriorates from current 

alarm status to red alarm status. 

▪ Vel (Maximum): The maximum Velocity of any historical data collection at the point/axis. 

▪ Env – (Maximum): The maximum Acceleration Envelope value of any historical data collection at the point/axis. 
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Advance Tendency continued (M20, M30, Phantom)  

Severity panel 

The Severity panel provides a ring chart overview of current machine health severities, based on the most recent 

recordings. (0-1=Inoperative, 1-2=Excellent, 2-3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor) 

Ring segments are divided equally among the next lower level of database, beneath the level selected (Areas when a 

Company is selected, Machines when an Area is selected, etc.). Colors are only intended to distinguish between ring 

segments. Colors are not an indication of severity or alarm status.    
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Advance Tendency continued (M20, M30, Phantom)  

Last Severities Avg panel 

The Last Severity Avg panel provides a bar chart overview of average machine health severities, based on the most recent 

recordings versus any currently-assigned alarm values: Velocity, Acceleration Envelope, Acceleration and/or Displacement. 

(0-1=Inoperative, 1-2=Excellent, 2-3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor) 
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Advance Tendency continued (M20, M30, Phantom)  

Severity & Slope panel 

The Severity & Slope panel provides a chart overview of average machine health severities and the degree of change 

between the last two recordings. The circle position on the graph indicates the current severity. The size of the circle 

indicates the slope of change between the last two recordings (whether increased or decreased). Smaller circles indicate 

little change between the last two recordings. Larger circles indicate a greater change between the last two recordings.   

(0-1=Inoperative, 1-2=Excellent, 2-3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor) 
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Advance Tendency continued (M20, M30, Phantom)  

Trending panel 

The Trending panel plots the highest velocity and acceleration envelope severities recorded each day, within the database 

level selected. (0-1=Inoperative, 1-2=Excellent, 2-3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor) 
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Saving and Uploading Data Files 

 

In several functions, DigivibeMX® generates its own files by ordering them in the database, however in the options such as 

 Generic Analysis and  Generic Balancing this does not happen since it is not assigned to any equipment. This 

does not mean that the signals can not be saved. On the contrary, the difference is that you can do it if you want through 

the toolbar in the File menu - Save or Save As button, or from the context menu - File - Save. 

  

DigivibeMX® handles several types of files depending on the function to which they correspond. They will be described 

below. 

 

File Types 

DigivibeMX® handles 8 different file types whose extensions are as follows: 

   

  

Extension Compatibility Description 

.anl DigivibeMX® 
Files of 1 single channel of vibration analysis. 

.anl DigivibeMX® 
2-channel rolling files. 

.asc DigivibeMX®, Notepad 
Text file containing all data in Alpha-Numeric format. 

.bal DigivibeMX® 

Balance Calculator session, retrieves all the information 

entered into the calculator. 

.uff Universal File Format 

This file is used by many vibration analysis software 

and ODS programs. 

.wav 
Sound file This file is compatible with any audio software. 

.jpg 

Pictures viewer It is used in vibration graphics and polar graphs. It is 

elective between BMP and JPG 

.bmp 

Pictures viewer It is used in vibration graphics and polar graphs. It is 

elective between BMP and JPG 
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Saving Files 

  

 

Save Options: 

   

- Button  Save the file corresponding to the visible session. 

- Button  Save as. 

- Button  File menu. 

- File menu - To export - As image:   Save the spectrum image. 

- File menu – Save – Save to Database:  Export to specific database. 

 

 

 

Opening Files 

Options to open files: 

- Button   Opens a selected file 

- File menu - Open: Opens a selected file 

- Double-click the desired file from the database file window: Open the selected database file in a new window. 
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Phantom Menu Tool 
 

This menu includes the tools necessary to configure, display and create alarms for Phantom devices. 

 

Wizard 
 

 

In this new window you will find the necessary sections to create the 

hierarchy of your database: 

 

Add Phantom 

▪ Add Phantom: Add a new Phantom sensor to your database. 

▪ Replace Phantom: Replace a Phantom sensor with a new one. 

Edit Phantom 

▪ Edit Phantom: Modify an already assigned Phantom sensor.  

▪ Delete Phantom: Permanently delete a Phantom sensor.. 

Review 

▪ Review: Lists all sensors added to the database. 

 

Tools 

▪ Battery Calculator: Calculator that allows you to define an 

approximate battery life time for your sensors. 

▪ Add GPIO Sensor: Adds units for general purpose sensors (4-

20mA and voltmeter). 

 

Add Phantom 

Add Phantom 

In this screen you can register one sensor at a time. It has two options: 

• Scan Code: Allows you to add the sensor through the QR code. 

• Manually: Allows you to add the sensor by means of its serial number (including the prefix). 

Once the sensor is added, you will see the description of the sensor type. Click on "Next". 
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In the next screen you have the option to create a group in which 

the Phantom sensors will be organized or you can choose from a 

previously created group with the drop-down menu.  

 

You can also assign a name and a description for the sensor. In the 

last option you can define the data sending interval (if applicable) for 

the added sensor. Then click on Next. 

 

 

 

 

 

 

 

 

 

The next screen allows you to assign the sensor to a specific point 

on the machine; you can choose among the available points that 

have not been previously selected for the same type of sensor you 

are adding. 

 

In case you do not have available points to add the sensor; you can 

use the "Add Machine" button to create a new machine with the 

points you need. 

 

 

 
In the next window you will be able to define basic configurations depending on your sensor, in this case you can choose 

the orientation of the axis of your triaxial sensor, however, you can also choose the value of your current clamps, etc. here. 

The next section of this window is where you can configure alarms depending on the parameter to be measured in your 

sensor, you can also define alarms for the battery level and internal temperature. These values can be set later. 
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When the sensor is set with the desired parameters, click next. The final 

window will appear showing a summary of the sensor you have just added. 

Click on Save Phantom and exit the Wizard. 

 

 

 

 

 

Replace Phantom 

This feature allows you to replace one sensor with another while maintaining the settings of the original sensor. To do so: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1- Identifies the original sensor ID. A summary 

of its settings will be displayed. 
2- Type the ID of the new sensor. A summary 

of its characteristics will be displayed. 

3- Confirm that the IDs are correct and press 

Replace Phantom. The action will be confirmed 

with the following notification: 
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Edit Phantom 

Edit Phantom 

This menu allows you to modify settings of the Phantom sensor such as Data Send Interval, Assignment Point, Axis 

Configuration, etc. Just type in the sensor ID and it will allow you to make the changes. In case the sensor is not in your 

database then it will allow you to add it to a machine 

Delete Phantom 

This menu allows you to permanently remove a sensor from the database. This action cannot be undone so you would have 

to add this sensor back to the database if you want to use it. 

 

 

Review 

Review All Devices 

 

 

 

 

Allows you to view the complete list of sensors assigned within the database. 

You can view general information such as battery status and internal temperature 

of the sensor. It is similar to the "Status" list. 

 

 

 

 

 

Tools 

Battery Calculator 

 

 

 

 

This window allows you to choose between Erbessd Instruments vibration 

sensors (Expert, ATEX, G2) and enter the settings that the sensor has stored.  

 

This will display an approximate battery lifetime, this is not an exact time, it is 

simply an estimate. 
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Add GPIO sensor 

 

 
 

It is a useful tool for setting custom units with user-defined parameters using Phantom general purpose sensors. In the top 

bar, select whether the unit to be created applies to 4-20mA sensors or to a voltmeter. This will change the parameters 

section according to each lower and upper limit corresponding to each sensor type. 

▪ Sensor type: Defines a sensor type for the created unit. 

▪ Sensor name: Assigns a name to identify the sensor and its unit. 

▪ Units: Select the unit from the unit library or create a completely new one. 

▪ Parameters: Select a minimum and a maximum for the sensor type and define which value applies to the minimum 

to generate a scale. 

▪ Calculate: Generates the calculation of the unit corresponding to the values set as minimum and maximum. 
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Status 

 

Tool that shows and overview of the sensors added to the database. The window shows name, type, sensor temperature, 

battery, assigned machine, etc. 

 

 
 

Signal Strength 

 
The Signal Strength option shows the quality of the connection for the Phantom device detected by the Gateway. Clicking 

the icon will display a wizard with the list of sensors and their checkbox. Selecting any of these (it can be more than one) 

will show the signal value of each individual sensor or sensors expressed in decibels, where a signal closer to 0 will be a 

stronger signal. 
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Set Up Tools 

Add GPIO Sensor 

 

It´s a useful tool to collect data through GPIO sensors, you can set up the 4mA to 20mA and de 0V to 5V sensors. It allows 

personalized units configuration with parameters defined by the user. With the blue plus sign it’s possible to access to that 

option. 

 

  

Power Off Configurations 

 

With this tool it’s possible to choose under what circumstances the sensors are required to be active. The New button allows 

to create the power off parameters of the sensors selected from the list. The blue plus sign allows to create a personalized 

unit. Once that the power off parameters are set, click Save and the settings will be assigned to the sensor.  
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Alarm Notifications 

 

With this window it’s possible to choose minimum alarm values for sensors that are assigned to a machine. The alarm 

options to choose are Higher than, Equal to and Lower than for the values defined in the axis boxes. 

 

Note: The Vibration and GPIO sensor can measure both their designated parameters and 

temperature as well. The alarms for the temperature are set separately and you can find a 

subsection in the alarm setup named “Accelerometer Temperature” and “General Purpose 

temperature” whichever the case. 



 
 

123 
Erbessd Instruments – DigivibeMX 11.50 noviembre 2022 

Reports (M30, M20, M10) 
 

To create reports on DigivibeMX® software, click on the New Report button from the Star Menu. Immediately will open the 

Report Manager Window, here you can select the Machines and the Points on which the report will be generated. Also it is 

possible to choose the preferred units for the values of the report and you can select to show a spectrum per point. 

 

 
 

Once that the selected options are correct, click on the Machine button to open the EI Report Designer. The EI Report 

Designer allows to modify the content of the report through various tools. The left panel includes tools to add visual 

elements to the report such as text boxes, images, shapes, forms, graphs, etc. 
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The lower panel includes the necessary tools to manage the data shown in the report. Clicking the Add Group and Add Sort 

buttons allows to select the required data form the dropdown menu. This data con also be Deleted or change the level or 

priority with the Move Up and Move Down buttons. 

 

 
 

 

The EI Report Designer includes tools menu that allows to customize the report. The Home menu includes the tools:  

• Report Tools: It allows to manage the save options of the report or to open a previous report. 

• Data Tools: It allows to add analysis parameters an also a database source to select the data needed to generate 

the report. 

• Clipboard Tool: Copy, cutting and pasting tools to add external or internal elements. 

• Font Tool: Basic tools for the report text style. 

• Alignment Tool: Allows to modify the text order of the report. 

• Borders Tool: Allows to create bold borders on the report cells. 

• Style Tools: Allows to choose a predefined style text between the lists of styles of the system. 

 

 

 

 
 

 

The Design Menu includes the tools: 

• Alignment Tools: Allows to modify of the graph data from its center. 

• Layout Tools: Allows to modify and manage the quantity and space of the rows and columns of a chart. 

• Page Tools: Organizes elements of the report and allows overlapping them. 

• Snapping Tools: It allows to snap elements from the report on the grid lines. 
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The Page Menu includes the tools: 

• Page Setup Tools: Allows basic editing of the report page- 

• Appearance Tools: Allows changing the color of the page and adding a watermark. 

 

 
 

The View Menu includes the tools: 

• Show Tools: Changes the report to a printing view. 

• Zoom Tools: Changes the zoom of the report pages. 

• View Tools: Changes the available windows of the Report Designer. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

126 
Erbessd Instruments – DigivibeMX 11.50 noviembre 2022 

Product Registration 

 
DigivibeMX® is a registered trademark and therefore requires an activation via the internet that can be made using the 

"Registry" option in the "Help" menu. It is essential to carry out this operation as otherwise the program could be suddenly 

deactivated.  

  

Updates 

  

DigivibeMX® is an application that is constantly updated. These updates are published on the Erbessd Instruments® page 

and are free to all users of Erbessd Instruments within the installed version. 

  

License  

DigivibeMX® is distributed with the license to use the software in a single equipment, reason why is prohibited any total or 

partial reproduction of said software, as well as the unauthorized distribution of the same one. 

  

Security and Copyright © 

  

DigivibeMX® is distributed without a registration code because it is part of a set of parts, however each edition of 

DigivibeMX® is compiled with the data of the company and the person to whom it has been delivered, which does not 

prevent its operation but is Will use to track the source of illicit software on the internet. The owner of the software that is 

unlawfully distributed will be liable to the corresponding legal penalties for illicit distribution of copyrighted material. Also, 

all the updates for that edition will be canceled. 

 


